This training allows maintaining the existing pages and creating new ones using SDL Tridion. You will learn how to Log into SDL Tridion, make text changes, make new pages, make a link, add images, insert or edit a table, upload documents, and send work for approval.
Table of Contents

Browsers ....................................................................................................................................................... 2
Log-in ............................................................................................................................................................. 2
Editing existing page....................................................................................................................................... 3
Fonts ............................................................................................................................................................. 5
Heading ....................................................................................................................................................... 5
Email Link .................................................................................................................................................... 6
Add an Image ................................................................................................................................................. 7
Upload an Image ........................................................................................................................................... 10
Link to pdf, Word doc, Excel, PowerPoint .................................................................................................... 15
Upload a pdf, a Word document, Excel, or PowerPoint presentation .............................................................. 18
External Link .................................................................................................................................................. 20
Internal link ................................................................................................................................................... 21
How to locate a component used by an internal page ..................................................................................... 24
Adding a Table .............................................................................................................................................. 26
Edit an Existing Table ................................................................................................................................... 28
Add an Anchor ............................................................................................................................................... 28
To finish editing the page at a later time ......................................................................................................... 32
How to preview the changes before submitting to workflow ......................................................................... 33
Submit to the Workflow ............................................................................................................................... 36
Create a New page ......................................................................................................................................... 37
Changing the page and the Component locations .......................................................................................... 38
Adding a New Component ............................................................................................................................ 42
How to access edited components Or Recent Items Feature .......................................................................... 44
**Browsers**
Tridion SiteEdit is compatible with all browsers, but Chrome is preferred.

Pop-ups blocker should be set to allow tcm pages to open.

**Log-in**
Navigate to the page to edit, and delete `www` and replace it with `stage` and click enter. Select the appropriate button *(Faculty/Staff or Student)*. In the logging window enter UML email address without `@uml.edu` *(@student.uml.edu)* and use your email password, and click Sign In.
You may want to bookmark this page for future editing.

Click the SDL Tridion button.

Once the logging is successful, the ribbon toolbar appears, set to the Home tab.

Editing existing page

Click on the content to see the border, and borders appear around editable pieces.

If the ribbon toolbar can be seen, but not the contents of the Web page, the browser may be preventing the content from being displayed because it does not consider the content secure. If this happens, do the following:

- In Google Chrome, click the shield icon at the right hand side of your address bar and select Load anyway.
- In Mozilla Firefox, click the shield icon on the left hand side of the browser address bar and select Disable Protection on This Page.
- In Internet Explorer, a message appears on the bottom of the Web page: "Only secure content is displayed." Select Show all content next to the message.

Tridion Experience Manager draws borders around editable areas in the web page (see image below)
If the Web page as a whole is editable, Experience Manager draws a border around it. By default, you only see it when hovering over the edge of the page, but you can make it always visible.

**Component (2)**
If a Component on the Web page is editable, Experience Manager draws a border around it. By default, you only see the border when hovering over the Component, but you can make it always visible.

**Field (3)**
If a field of a Component is editable, Experience Manager draws a border around it, but only if you select the Component first and then hover over the field. This also goes for fields within fields (4).

Borders and colors

The color of an item border tells you something about the status of that item. By default, an item can have a border in one of the following colors:

**Blue**
A blue border indicates that you can edit the item.

**Green**
A green border means that there are pending changes to this item for you to commit or discard.

**Red**
A red border means that your changes cannot be saved, because the content you entered is invalid or incomplete.

**Grey**
A grey border means that you cannot (currently) edit this item.

These colors are defaults. Your application administrator may have changed them. The color of borders around the fields of a Component are as follows:

- If the Component has a blue or green border (or its configured alternative), so do all of its fields.
- If the Component has a grey border (or its configured alternative), its fields have no borders.
- If the Component has a red border (or its configured alternative), the field or fields that are invalid also have a red border.
Auto save is enabled, there is no need to save changes that is why the Save Draft function is grayed out

Fonts
For design purposes, the font style and the color are not to be changed.

If the content is prepared in a Word document, copy and paste to Notepad or other text editor first then copy from Notepad to your page. You can also use Sublime as a text editor (https://www.sublimetext.com/3). To format the content, use the formatting toolbar.

![Formatting Toolbar](image)

Formatting Tool bar

The Text Field Properties windows can be closed.

![Text Field Properties](image)

Text Field Properties

The first title in the component is always heading 2 by default.

Heading
Only heading 2 and heading 3 are used in editing content in Tridion. To apply a header to a content box, highlight the words you want in the headline and select heading 2 or heading 3 from Section Type in the formatting tool bar. Or just place the cursor in the line that needs the header change and select an option (2 or 3 only) from the dropdown menu.
To save the changes click outside of the component frame.

Email Link

To link to an email address, highlight the content you wish to link (it is preferable to type the whole email address), in the ribbon tool bar select Insert tab

Then click Hyperlink.
Now under **Type** field select **mailto**, in the **URL** field after **mailto:**(no space) type the appropriate email address, and in the **Title** field add a description of the email (or the person’s name), then click **OK**.

![Insert Hyperlink](image)

**To save the changes click outside of the component frame.**

**Add an Image**
Click at the beginning of the paragraph when you want to insert the image.

![Image](image)

Select the **Insert** tab in the formatting toolbar

![Insert Tab](image)

Then click **Image** button
After the Image pop up window is displayed

A window slide on the left will display the folder Building Blocks, click on the arrow.

Then click Content.
Navigate to the desired folder within your department folders.

Go to Multimedia folder.

Click Images folder.

Select the image you want to insert.

And click Select on the top of the slide window.
Click **Advanced** to format the image.

- In the Alignment field select float right

*The image should be minimum 600 x 400, and try to keep the size within 1 MB*

- Keep the Proportion field checked
- Do not change the image’s dimensions
- Then click **OK**.

**To save the changes click outside of the component frame.**

**Upload an Image**
To upload an image:

Click at the beginning of the paragraph when you want to insert the image.
Select the **Insert** tab in the formatting toolbar.

![Insert tab](image1.png)

Then click **Image** button.

![Image button](image2.png)

After the **Image** pop up window is displayed.

![Image pop up window](image3.png)

A window slide on the left will display the root folder **Building Blocks**, click on the arrow.
Then click **Content**.

Navigate to the desired folder in your department.

Go to **Multimedia** folder.

Click **Images** folder.

Then drag and drop the file in the bottom field, or click the grey bar.

Drag and drop is straight forward.
Click to upload will prompt a new window, which will allow you access to your computer or shared drive or USB drive.

Find the image you want to use, select then click **Open**.

The Metadata window is open to edit the image’s alt text.
In the Image alt text field type a good description of the image, then click **Save and Close**

And click **Select** on the top of the slide window.
Click **Advanced** to format the image.

- In the Alignment field select float right

*The image should be minimum 600 x 400, and try to keep the size within 1 MB*

- Keep the Proportion field checked
- Do not change the image’s dimensions
- Then click **OK**.

**To save the changes click outside of the component frame.**

**Link to pdf, Word doc, Excel, PowerPoint**

Type the name of the text file to add to your page, and add the extension in parentheses in the format below: File name (file extension).
For example: Test 1 (pdf), or test 2 (docx) ...

*pdf file* (pdf) highlight the name of the file but not the parenthesis.

In the ribbon toolbar select **Insert** tab.
Then click **Hyperlink**.

In the following popup window select **Component** for **Type** and **New Window** for **Target**.

Click browse button.

A window slide on the left will display the **Building Blocks** folder, click on the arrow.
Then click **Content** and navigate to the desired folder.

Inside the desired folder navigate to **docs** folder where all the pdf, word documents and excel files are stored.

Click on this folder, and locate the file you want to use.

Then click **Apply**.
In the Hyperlink window, click OK.

To save the changes click outside of the component frame.

Upload a pdf, a Word document, Excel, or PowerPoint presentation
Highlight the content to be linked to the file.

In the ribbon toolbar select Insert, then Hyperlink.

Select Component, and set the Target to New window.
In the slide window navigate to the right folder.

Then navigate to **docs** folder within your department.

Click on the folder.

Then drag and drop the file in the bottom field, or click the grey bar.

Locate the file to upload in your computer, double click on it. The file name should not include any character such as +, #, &, @, %, !, and /

Once the file is visible in the docs folder click Apply.
Then click **OK** in the **Hyperlink** window.

To save the changes click outside of the component frame.

**External Link**

Any link outside of Tridion is considered external link. A typical Tridion page is in the format: [www.uml.edu/dept/.../PageName.aspx](http://www.uml.edu/dept/.../PageName.aspx), or when www is replaced by stage the login button should appear 🖥️.

Highlight the content to be linked, and in the ribbon toolbar select **Insert** tab, then **Hyperlink**.

In the following popup window leave the type as **HTTP://**. And **New Window** for **Target**. Empty the URL field then paste the external url.

Make sure the new address does not duplicate [http://](http://) or [https://].
Check if the link is working by clicking folder/arrow icon.

To save the changes click outside of the component frame.

**Internal link**

Any link within Tridion ([www.uml.edu/dept/.../PageName.aspx](http://www.uml.edu/dept/.../PageName.aspx)) is considered an internal link and linking to a Tridion page is done by linking to the component used by that page. Whereas The URL of the page you are trying to link to can change and the only way to avoid a broken link is to navigate and link to the component used by that page.

First highlight the content to link then select the Insert tab in the ribbon tool bar

Then click **Hyperlink**.
In the next window select “Component” under Type, and Default for Target.

Then click the browse button.

A slide window will appear in the left.

Click on arrow next to Building Blocks. Then click Content.

Navigate to the desired folder.
Once in the right folder look for the component.

Select the component you want to use, and then click **Apply** on the top of the slide, or double click.
The title field should provide a description as to where the link takes you. Once done, click OK.

**Note**
When linking to landing pages, select a component named “link this for the dept. landing page.”

**How to locate a component used by an internal page**

Open the page to link to, then change www in the URL with stage and log-in to Tridion.

Right click inside the component, and select Open in the form view.

Click the Info tab.

In the example below: the component name is “test-Amy” and the location is the main “Admissions” folder.

Will be the component and the name will be displayed at the right.

And
will show the component’s location in the Content Manager (back-end).

Then you follow the procedure under Internal Link section.

**Method two:**

To link to this page

Replace WWW with Stage, then click the blue pen.

Right click inside the component, and open in form view. In the URL field copy the tcm id (i.e tcm:16-224952)
Now you can link to this page by selecting Type: Other, and in the URL box paste the tcm id. (example below).

Click Ok.

**Adding a Table**
Place your cursor at the location where you want to insert the table. In the ribbon toolbar click **Insert** tab, then **Table** button.
When **Insert Table** window appears, enter the numbers of rows and columns. Click **OK** when done.

A table editor window will pop up.

By default, the content will be **Body** style (normal formatting).

To make table heading: select **Row** tab, click inside the row, and in the **Row** Formatting menu in the **Body/Header/Footer** section select **Header**.

Then click **OK**.

In SiteEdit mode click inside the cell and type the table content.

**To save the changes click outside of the component frame.**
Edit an Existing Table

To edit an existing table, click inside the table,

In the formatting toolbar select **Format** then under **Current Elements** drop down menu select *Table*, then click **Table** button under **Insert** tab.

In the **Table Editor** window click inside any cell to activate the top menu which will allow you to remove/insert row above or below, remove/insert column to the left or to the right …

Apply the changes, and click **OK**.

**To save the changes click outside of the component frame.**

Add an Anchor

An anchor is a link to a named position in the same page. To insert an anchor, move the cursor and click at the desired position where the hyperlink can point.

To have a quick links to different sections in the content, you can make the sections titles anchors, and duplicate them at the top of the content. You can then link the top titles with the corresponding sections.
For example: the cursor will be moved right before “Celebrating national library week” (same line) as shown below is the section’s title, and single click. The next step will be to click Insert tab then Anchor.
Select Anchor button, in this case the anchor will be named (no space when naming anchors), and click Ok.

For the purpose of training we will name this anchor “libraryweek” then click OK.
Highlight “Celebrating national library week” from the top duplicated titles

select Hyperlink button,
Under Type field select Anchor, and under Anchor field chose the corresponding anchor “libraryweek”.

Click Ok.

**To save the changes click outside of the component frame.**

**To finish editing the page at a later time**

Click the link icon in the top right of the editable border.

Copy and save your URL somewhere where you can easily find it.

Then click the in the top right of the Tridion page **not the browser**.
Click **Continue editing later**.

When ready to edit the page just paste the saved URL, and log-in to Tridion.

When prompted with the message.

On the page’s top right click to update.

Or Click **Update Preview** in the ribbon toolbar

**How to preview the changes before submitting to workflow**

After editing the page, click outside the component being edited.

Under Home tab in the ribbon toolbar, click **Finish Editing**.
To preview the page before submitting, click Things to do tab in the top left

Select the component to preview

Click Finish Activity

And in the Next activity drop down menu select Publish for Preview
Then click **Done**

Now copy the stage page url by click 📦

Paste it in a new browser tab to check the links and the page layout.

Now go back to “Things to do” and click “Assigned”. Select the component you are working on and
Click Start Activity if more edits are required, and click inside the component. Otherwise follow the next steps.

Submit to the Workflow
Click Finish Activity

Finish Activity Message: In the comment box type the summary of all the edits and a message to the webcontent team if needed. Remember when you submit to the workflow, by default the page will be published live. If you want the page to go stage only, you need to mention it in the comment box and type “publish stage only”. Also if you need to add a page to navigation (left hand menu in the live website) mention it in the comment box and specify the exact location in navigation.
In the Next Activity menu select Submit to workflow, and click Done
Then click Done.

Create a New page
Under the ribbon toolbar, select Home tab then click New Page.

Select a specific page in your department from the slide window to the left.

For Admissions website use either:
- Admissions News page
- Admissions Page
For other departments “Admissions” will be replaced by your department name automatically.

Click Create.

In the pop-up window fill in the Page Title, and the File Name. In the File Name use a dash and avoid spaces.

Changing the page and the Component locations
You can change the page location if needed (if you have more than one folder in your department) by clicking Change next to Page location field.

And in the window slide navigate to the right folder (pink color) then click Change.
If you need to change the location of the component click the Configure Folders for Components button. Then click browse. Navigate and select the desired folder (yellow color), then click select.
Click Create Page.
The page will reload with a blank page.

Hover the mouse over [Page Title] and right. Then select **Open in Form View**.

The page will be open in the back-end of Tridion rather than Experience manager (SiteEdit).

You can edit the display title and add a navigation title if needed.
click **Save and Close**.

**Adding a New Component**  
In the ribbon toolbar, click **Home** tab, then under **Insert Content** select **Create and Insert new Content**.

In the slide window click **Main Content** then click **Choose**.
In the pop-up window fill the **Content Title**.

Change the location by unchecking the **Use Default Folder** and click browse, navigate to the folder corresponding the page’s folder (same name just the color is yellow). Then click **Create and Insert Content**.

**Note: Name the component the same name as the page**

After the page is refreshed (automatically) the component is added to the page, and it displays a heading and content allowing edits.
To start editing just click inside the content, and follow the directions from the beginning of this manual.

**How to access edited components Or Recent Items Feature**

The Recent Items list displays the last 10 items saved by the user. The Recent Items list is available in both the Tridion Content Manager Explorer (CME/Backend) and Experience Manager (XPM/SiteEdit) editor interfaces. The purpose of this user interface feature is to allow a user to easily access an item which they have recently saved without having to navigate to the location of that item in either editor. This is especially useful in XPM’s case where a user is dependent on the website’s navigation structure alone to navigate to content they wish to edit. The feature is activated by clicking the Recent Items icon, located to the right of the workflow activities and notifications icons on the user information bar in the top right hand side of the editor window:
A list of items recently saved by this user will expand. If the user has not yet created any new items or updated any existing items an empty list will display indicating the last edited items will show when available:

If there are recent items available, each item in the list contains the following information:

1. Item Icon
2. Item Title
3. Date/Time when the user saved the item
4. Location of the item (either the Stage page URL or CME location)

The types of items that are displayed in the Recent Items list varies depending on the context interface, CME or XPM. In the CME interface all types of items the user can edit will be listed in the list. In XPM the types are limited to Pages and Components.

<table>
<thead>
<tr>
<th>CME/Backend</th>
<th>XPM/SiteEdit</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Recent Items CME" /></td>
<td><img src="image2" alt="Recent Items XPM" /></td>
</tr>
</tbody>
</table>

When the user double-clicks an item in the list in the CME interface, the item editor for the specific item type will open in form view in the backend. If the item is an organizational item such as a folder or structure group, the CME will navigate to that location in the backend.

When the user double-clicks an item in the XPM interface, the feature will first attempt to browse to the page (or related page in case of a component) which is published to the stage environment. If no such page is available the item will be opened the in form view in the backend.
The list cannot be directly modified by the user. If a user wants a sticky item they should make use of the favorites feature in the CME.